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HTML Assistant - Freeware Version
HTML Assistant    is copyrigh,t ©1993,1994, by Howard Harawitz and Brooklyn North Software 
Works, All Rights Reserved.
This version of HTML Assistant is freeware.    Although the software and its documentation is copyright, 
there is no obligation to register or to pay any fees for personal use. 

There is a commercial version, HTML Assistant Pro, with advanced features.    It includes a printed 
manual and is fully supported. 



Disclaimer
Please use this software at your own risk.    
The author, Howard Harawitz,    and Brooklyn North Software Works disclaim any liability for 
special, direct, indirect, incidental, consequential or any other damages believed to have been 
caused by the use of HTML Assistant or any files derived from its use.



Copyright Notice
HTML Assistant and its associated documentation is Copyright ©1993,1994 by Howard Harawitz 
and Brooklyn North Software Works, All rights reserved.
This version of the software, HTML Assistant, may be freely distributed, but all copies must include this 
notice, the Help file and all other files and documents associated with the original distribution package 
without modification. 

Disclaimer

For further information or if you have any suggestions or comments please contact the author, Howard 
Harawitz:

Email: harawitz@fox.nstn.ns.ca

Telephone/FAX: (902) 835 - 2600



What is HTML Assistant?
HTML Assistant is a text editor with extensions to assist in the creation of HTML hypertext documents.    
HTML documents are used to access a variety of information sources with a World Wide Web browser 
such as Netscape, Mosaic or Cello.

More than just an editor, HTML Assistant also includes many special functions that help you to organize 
your Internet experience and to keep track of URLs, the pointers to information that you discover on the 
World Wide Web.

This version of HTML Assistant includes:

Context Sensitive Help -- Press the F1 key for help with the currently selected control or menu item

A status bar -- pass the mouse pointer over any control and the status-bar (at the bottom of the main 
screen) tells you what the control is for

Capability to test and view your work with WWW browsers of your choice at the 'click' of a button -- 
without leaving the editor. 

A multiple document interface (more than one file may be opened at one time)

Use of special, easy to create and edit, HTML Assistant URL files for organizing and quickly 
combining URLs from different sources -- including Cello Bookmarks, and NCSA Mosaic menus 
and hotlists.

A unique "URL Editor" which permits rapid editing and compilation of URLs from any    number of 
these sources.

Automatic one-step conversion of HTML Assistant URL files, Cello Bookmarks    and Mosaic '.INI'    
files to HTML    text.

User defined toolkits with the ability to save user defined tools to files for repeated access.

Automatic conversion of Unix text files to DOS text

Printing of text files

If you want a manual with tutorials, plus more capability...
There is a commercial version of this software, HTML Assistant Pro, that may be ordered via mail, fax, or 
Email.

In addition to the features described above, HTML Assistant Pro also includes:

A printed manual with a "Beginners' Guide To HTML" plus a step by step tutorial for creating HTML 
pages

An Automatic Page Creator which permits rapid creation of HTML text pages for use with WWW 
browser programs.    Minimal knowledge of HTML is required, and attractive screens with your 
own selected hypertext links can be created in a few seconds.    This makes it easy to create 
'menu' pages on your hard drive so you can systematize and organize URL links by subject, date,
etc.

The ability to remove HTML markings, and to use special reformatting filters to transform hard-to-
decipher HTML files into clear, readable text.

The ability to quickly and automatically extract and copy URLs    from HTML files, like NCSA's "What's
New" page, for easy organization and compilation into your own documents.

File search features - you can search your hard drive, and locate files by file suffix (i.e., *.htm, *.txt) 
which contain key words that you select. 

Ability to load files that are longer than 32K.    Large (>than 32K) files may be loaded in segments.



An option to save DOS text files as UNIX text

Full support, including the availability of enhancements and upgrades

More    about HTML Assistant Pro



Subscribe to the HTML Assistant Newsletter
For continuing updates and news about HTML Assistant software, you can subscribe to an Email 
publication, the HTML Assistant Newsletter.    Published "semi-irregularly", and delivered (free!) directly to 
your (virtual) door, the Newsletter includes announcements, bug reports and news about HTML Assistant 
software.    It also is a source of information of general interest to users of the World Wide Web -- 
including text and HTML pages about learning HTML, interesting WWW sites, commentaries on the use 
of the Web, feedback and suggestions from users, etc.

To subscribe, send Email, with the word "subscribe" (quotes are not necessary) in the 'Subject:" field, to 
harawitz@fox.nstn.ns.ca.    You may also include comments or suggestions in the text field of your 
message.



Overview
Keeping an accurate record of    Internet journeys is not a trivial task.    In fact, one of the major criticisms 
of the Internet is that information is not well organized and it is difficult to retrace your steps if you want to 
repeat a search.    Many (if not most) Internet users have found themselves using computers to scan the 
Internet for information while keeping    a pencil and paper handy so that they could make notes about the 
places they had been.

Some Gopher and WWW browser packages permit saving place markers by using 'bookmarks'    or a    
'hot list' to collect address information.    As useful as this is,    after several searches or browse sessions 
these collections quickly become a pot pourri of tags, markers and pointers to a varied assortment of 
Internet places that have no particular relationship to each other.

By making it easy to create your own browser pages, HTML Assistant provides a way to organize and 
keep track of your Internet journeys.



What is a URL?
"URL" is an abbreviation for "Uniform Resource Locator". 

URLs are the pointers to information to be retrieved when a hypertext link is activated by the user.    They 
tell the browser how information is to be obtained and where it is located.

URLs enable a single WWW browser program to incorporate many of the functions that normally require 
several other software packages, including FTP, news, Email and gopher.

The general format of a URL is :
prefix host.domain[:port]/path/filename 
Note: The space after the word, "prefix", is used only for clarity.    In a URL, there is no space following the
prefix.

The port number may be omitted from the URL, unless it differs from the recognized standard port for the 
indicated service. 

The following are some of the prefixes that are commonly used, along with their function:

ftp://    [retrieves a file from an FTP server]

http:// [retrieves a file from a World Wide Web server]

file://localhost/    [retrieves a file that resides on the same computer as the browser - a "local" 
file]

gopher://    [retrieves a file from a Gopher server].

Some URLs do not use the double slash (//).

mailto:    [requests the browser to enable the transmission of an Email message]

news:    [retrieves a Usenet news message]

The following are examples of properly constructed URLs:

"ftp://ftp.cs.dal.ca/htmlasst/htmlasst.zip", 

would be used in an HTML document to enable a browser to retrieve the file, "htmlasst.zip", from an FTP 
site;

"file://localhost/c:/www/myfile.txt", 

would cause the browser to retrieve and display the file, "myfile.txt" from the user's local disk drive;
"http://www.cfn.cs.dal.ca/Media/News/TodaysNews.html",
would result in the retrieval and display of an HTML file from a WWW server.



Collecting URLs
World Wide Web browsers use Uniform Resource Locators (URLs) to find and access all forms of 
information on the Internet -- including text files, news groups, mail lists, gopher directories, HTML 
documents, program files, images, sounds, movies, etc.

To use HTML Assistant as an aid to organizing your WWW experience, you first need to begin collecting 
the URLs that point to the WWW sites that interest you.

Two MS Windows browsers, Cello and Mosaic, both permit transferring the URLs which they use for 
Internet access to the Windows clipboard.    From the Clipboard they can easily be copied to any Windows
text editor.

With Cello, use the mouse to point at a link on Cello's main display page, and then, click the right mouse 
button to bring up a dialog that will permit you to copy the link's HTML code to the clip board.

Mosaic has a URL text display which can be copied by selecting the text (using the mouse and 'dragging' 
across it) and typing Control-C -- the standard MS Windows key sequence for copying text to the 
clipboard.    Later versions may also include a copy function in one of the menus.    

Once the URL text is in the clipboard it can be 'Pasted' into a text file using a simple text editor like MS 
Notepad (supplied with Windows) or HTML Assistant.    Be sure that there is an End-of-Line following the 
URL. An End-of-line is a carriage-return/linefeed pair which is added when you press the 'Enter' key after 
inserting text. That is all that is required to begin collecting URL links for use by HTML Assistant.

Alternatively,    as you explore with a browser, you can save URLs by creating bookmarks (if you are using
Cello) or adding to the 'hot list' (if you are using mosaic).    HTML Assistant's URL file editor will permit you
to convert Cello bookmark files and URLs collected in Mosaic's menus and Hotlist to HTML Assistant URL
files.    HTML Assistant will permit you easily to create URL files that combine information collected with 
both browsers.

Files containing URLs should be saved with the suffix, ".URL".      While this isn't absolutely necessary, it 
does make it easier for you (and HTML Assistant) to identify them.



Editing and Organizing URLs
Once you have collected    URLs that point the way to the places you have visited, the next step is to 
select and organize them into separate files that suit your particular needs.    For example you might want 
to create a file containing URLs that can help you learn about Internet resources, or interesting art 
exhibits, or information on animal breeding.    

HTML Assistant provides two ways to do this.    Use whichever works best for you.    

The most familiar way for most people will be to open a new edit window (by selecting 'New' from the 'File'
menu) for each subject and copy/paste selected URLs (and their optional comments) from your general 
URL collection    or other URL files to the new one.

The second method involves using the URL file edit popup window that can be viewed by selecting    
'Edit/Build URL Files' from the 'URL' menu.    This permits you to combine commented URLs from different
sources and to use scrolling lists for editing.



Building Browser Pages
The URLs you have collected are pointers to the places you    have visited on your Internet journeys.      
The final step in organizing your personal Internet experience is to incorporate selected URLs into HTML 
documents to be used as WWW browser pages.    These pages will be the tour guides for yourself and 
others who want to retrace your steps.      With HTML Assistant you can easily create browser pages with 
titles, headings and descriptive text, and hypertext links to Internet resources.

HTML Assistant can quickly convert    URL files to HTML hypertext links.    For information about how to do
this see    Direct Conversion of Files to HTML Text.

Using HTML Assistant tools and editing functions you can easily format your links into formatted lists 
(numbered or unnumbered), intersperse them with descriptive text, and create headers in various sizes 
and styles to highlight your page.

HTML Assistant Pro, includes an Automatic Page Creator that makes this part of the job very easy.    It 
guides you through the process of creating a title, headings and descriptive text for your page, and 
enables you to incorporate a list of URLs (from a file of your choice) which will become the links to the 
places you want to visit. With the 'click' of a button    your new page is automatically created and displayed
in an edit window ready for saving as an HTML document. 



Using Local Files with HTML
As you create your own HTML files with links to remote sites, you may also want to create other browser 
pages consisting of links to these local files.    By doing this with successive generations of locally created 
files you can create a hierarchical system of    'menu pages' for organizing and indexing your work.

For example, you may have built separate files (with remote links) concerning the following subjects:

Using HTML

WWW and related FAQs

Selected sites via CERN

You might want to create a menu file concerned with general WWW topics that includes the above files as
selectable links.

Creating a Menu Page 
You can build such a file one step at a time, by opening a new edit window and creating a local file link for
each file using the 'Link' button.    When the link popup appears, select the "file://localhost/" prefix from the
prefix list box.      

Next, enter the name of a file, or use the 'Browse' button to select a file name from a file select dialog box.

Clicking the 'OK' button (on the link popup) will cause HTML Assistant to create (and insert into the edit 
window) the URL for a link to the file you selected. It will look something like:

file://localhost/C:/html/myfile.htm
You can continue in this manner to add additional URL links.    Using HTML Assistant's list formatting 
capability, you can select and format the file links as one or more lists (numbered or unnumbered).

When the process of adding and formatting file links is finished you can complete your menu page by 
using HTML Assistant's HTML formatting tools to add a title, headers and explanatory text to your display.



Overview
Note:    Not all menus or menu options are visible upon startup.    The menu bar, and the contents of most 
menus, changes when at least one document window is open.    To view all the menus, if they are not 
already visible, either open a file or a new document.

HTML Assistant's menu's may seem formidable at first.    There are a number them, and each one 
presents many options.

While this bewildering array of choices can be confusing, once you become familiar with the menu 
structure, you will learn that they present many opportunities for you to simplify and speedup the creation 
of your HTML documents.

Many of the options, such as those in the "File" and "Edit" menus, will already be familiar to you because 
they are found in commonly used word processors and text editing software.    

The fastest way to learn to use any of the menu options is to try them.    Just be sure that you have 
another, saved copy of the document that you are experimenting with. 

While learning, you can use the "Hold" button on the text window to keep a "snapshot" copy of the current
state of your document.    Clicking the "Recall" button will bring it back, just as it was immediately before 
you decided to "Hold" it.

This section will be devoted to explaining how to use the menu features that are unique to the creation of 
HTML documents with HTML Assistant.



The "File" Menu
Inserting a File at the Cursor
Set Test Program Name



Inserting a File at the Cursor
The "Insert file at cursor..." option in the "File" menu permits you to load and insert another file into your 
document at the cursor position.

This is most useful for inserting "boilerplate" text that appears in several documents. For example, you 
might want to insert information about how to contact you by Email, into a series of HTML pages.

When you select this option, a file select dialog box will appear. Simply select the file you want to insert 
and click the "OK" button to insert the file.



Set Test Program Name
If, as you are editing a document,    you want to view or "test" your work with a World Wide Web browser 
without leaving HTML Assistant, you need to let the software know where your test browser can be found.

You can tell HTML Assistant which browser to use by selecting the option, "Set test program name...", 
from the "File" menu.    The dialog boxes will lead you through the process.      Using the appropriate list 
boxes, select the path and filename for your browser.    If you want the software to "remember" where the 
browser can be found, so that you don't have to repeat the process each time you start the program, 
select the "Yes" button when asked if you want to save it as a "permanent test program name".



The "Options" Menu
Use DDE with Cello
Autosave File Before Test
Configure Paragraph Button
Use Lower Case HTML
Default Font
Edit User Tools
Hide Lower Tool Bar



Use DDE with Cello
If you are using Cello as your    test browser, HTML Assistant gives you the option of using DDE (Dynamic
Data Exchange) to send Cello the name of the HTML file you want to test.    If Cello is not loaded, HTML 
Assistant loads it.    Once Cello is loaded and you do not close it, it will not have to be reopened whenever
you want to test a file.    Each time you select the item in the File menu for testing using DDE, or the "Test"
button on a document window, the name of the file you are testing is sent to Cello and it becomes the 
active, topmost application.

When using DDE, Cello does not always refresh itself if your file has changed.    That is, changes in your 
HTML text will not always be immediately seen when you invoke Cello.    If that happens click the 'Reload 
Document' option in Cello's file menu to ensure that you are viewing the latest saved version of your 
HTML file.

Clicking on the small 'Return to HTML Assistant' box in the lower right    corner of Cello's window will 
return you to HTML Assistant without closing Cello.



Autosave File Before Test
 Selecting the "Autosave Before Testing" feature in the "Options" menu, will cause any changes in your 
file to be saved automatically before it is tested.    In order for you to give the file a name, new files must 
be saved manually before they can be tested the first time.



Configure Paragraph Button
Selecting the "Configure Paragraph Button" option from the "Options" menu will display a sub menu with 
several choices involving the placement of "newlines" in the text whenever the button that inserts a new 
paragraph tag is clicked.

The best way to find out what these do is to experiment.

This option affects only the way your text is displayed in the editor. It has no effect on its appearance 
when displayed by a browser.



Use Lower Case HTML
If this option is checked (i.e., selected) then all text in HTML markings will be displayed as lower case.    
Otherwise, they will be displayed as upper case.

HTML is not case sensitive, so choose lower case display if it suits you.



Default Font
This option permits selection of the font and font characteristics (i.e., bold, size, etc.) which will be used 
as the default for all new text windows.

The font for text in an individual window that is already displayed, can be changed by using the "Font 
(current window only)" option in the "Edit" menu.



Edit User Tools
Selecting this option will open the "Edit User Tools" dialog.    This permits changes to the "User Tools" list 
displayed on the main window tool bar.

The small button, with an "E" on it, immediately above the "User Tools" display will also open the "Edit 
User Tools" dialog.



Hide Lower Tool Bar
Selecting and deselecting this option toggles the display of the main window's lower tool, or "button", bar.

The small button, with a "T"    on it, at the right hand end of the main tool bar has the same function.



The "HTML" Menu
Selecting an option from the upper part of this menu, will cause the HTML code, as displayed, to be 
inserted at the cursor.      These items are duplicated on HTML Assistant's main window tool bars.    They 
can be handy when the lower tool bar is not visible.

The four characters, "<", ">", "&" and """, on the lower part of the menu require special HTML code in 
order to be displayed properly.    Clicking on one of these special characters will cause its HTML code to 
be inserted at the cursor.



The "Command" Menu
Repeat Last Command
Autoinsert Paragraph Marking
Autoinsert Line Breaks
Create Formatted Link
Insert Horizontal Line
Display Standard Document Template
Mark Selected Text as BODY
Mark Selected Text as HEAD
Mark Selected Text as HTML



Repeat Last Command
This option causes the HTML code inserted as a result of the previous command to be redisplayed at the 
current cursor position.

This duplicates the function of the "Repeat" button on the document window tool bar.



Autoinsert Paragraph Marking
This will insert new paragraph tags ("<P>") wherever a newline is found in the selected text.    Tags will not
be inserted on empty lines.



Autoinsert Line Breaks
This will insert line break tags ("<BR>") wherever a newline is found in the selected text.    Tags will not be
inserted on empty lines.



Create Formatted Link
This option converts a single line containing a URL, followed by its "Clickable" text, to a formatted    "<A 
HREF...", link.    The line to be converted must first be selected with the mouse.

For example, the line:
www.nsac.ns.ca/,Agricultural College Site
would be converted to:
<A HREF="www.nsac.ns.ca/">Agricultural College Site</A>
Note the comma (",") separating the URL from the clickable text in the original line.    This is required, 
unless there is no clickable text.



Insert Horizontal Line
Inserts a "Horizontal Rule" tag ("<HR>") at the cursor.



Display Standard Document Template
Displays the HTML tag pairs that are required for delineating the structure of an HTML document.

The following code is displayed at the cursor position:
<HTML>
<HEAD>
<TITLE> </TITLE>
</HEAD>
<BODY>
</BODY>
</HTML>



Mark Selected Text as BODY
Encloses selected text with the "body" tag pair, "<BODY></BODY>"



Mark Selected Text as HEAD
Encloses selected text with the "head" tag pair, "<HEAD></HEAD>"



Mark Selected Text as HTML
Encloses selected text with the "HTML" tag pair, "<HTML></HTML>"



The "URL" Menu
Items on this menu relate to editing, extracting and generally working with URLs.

Related Topics:
Create Local File Reference
Autoconvert File to HTML
Edit/Build HTML Assistant URL Files



Create Local File Reference
Selecting this option brings up a file select dialog. Selecting a file, causes a local file URL to be inserted at
the cursor.

For example, selecting the file, "d:\images\picture.gif" will cause the following text to be inserted at the 
cursor:
file://localhost/d:/images/picture.gif



Autoconvert File to HTML
Selecting this option will bring up a sub menu with options for selecting file types from which URLs and 
their associated "clickable" text will be automatically converted to HTML text.    The HTML text will be 
displayed in a document window.

You may convert URLs from Cello Bookmark files, NCSA Mosaic's "Mosaic.ini" file, or HTML Assistant 
format ".url" files.



Edit/Build HTML Assistant URL Files
Selecting this item from the 'URL' menu brings up a dialog window that permits you to edit and combine 
commented URLs    from different sources.



Tools Overview
HTML Assistant's tools can be accessed by means of    two tool bars at the top of the program's main 
window.    There is also menu item labeled "HTML" which permits the insertion of HTML tags.    The top 
tool bar is always visible. The lower one, called the button bar, can be hidden, by clicking the small button 
marked "T" in the lower right hand corner of the upper tool bar.    The button is a toggle. Clicking again will
restore the lower tool bar.

The tools are basically of two types:

Tools that normally involve the selection of text, and which mark the selected text by bracketing it 
(Type 1 tools.)

Tools that insert HTML elements at the cursor (Type 2 tools.)

The tools accessible on the upper tool bar are, with one exception, Type 1 tools that involve the selection 
of text.      The exception is the button marked "<P>", which inserts an end-of-paragraph mark at the 
cursor.    

To use the Type 1 tools, highlight the text you wish to select by 'dragging' the text cursor across it.    Then, 
with the mouse cursor over a tool bar button, press the left mouse button to view a popup menu.    
Selecting a menu item (by 'clicking') will cause the appropriate HTML markings to bracket the selected 
text.    

The tools listed on the "HTML" menu are all Type 2 tools which insert HTML markings at the cursor.    
'Clicking' on    a menu item will cause the displayed HTML text to be inserted.    

There is also a special group of    insertion (Type 2) tools called 'User Tools.'

See also:
The Auto Repeat Function



Using Bracketing (Type 1) Tools
To use the Type 1 tools, highlight the text you wish to select by 'dragging' the text cursor across it.    
Selecting a tool bar button (by 'clicking') will cause the appropriate HTML markings to bracket the selected
text.    

The 'List' tool items work with several lines of text.    Select a few lines of text and try them.

A few Type 1 Tools are a bit more complicated.    They ask for additional text to be added by the user as 
part the HTML element that they apply. The 'Link' tool is one of these. So are the 'Anchor' and 'Image' 
tools.    Try them to see how they work.



The 'Link' Tool
When the "Link" button is selected, a window pops up asking for selection or entry of a 'URL'.    URLs 
(Uniform Resource Locators) are instructions for fetching data.    Each URL type has a prefix (as shown in
the URL Prefix List box) indicating the kind of data that will be fetched. 

As you enter and use URLs in your documents they are saved in memory and appear in the URL list box 
whenever the URL data entry window pops up.    You may save the contents of this list box to a file, and 
retrieve the contents of a saved file to the list box by accessing the 'URL File' menu on the URL pop up 
window.



Using Insertion (Type 2) Tools
The tools listed on the "HTML" menu are all Type 2 tools which insert HTML markings at the cursor.    The 
upper tool bar button labeled, "<P>" is also a Type 2 tool.    'Clicking' on    a menu item, or the button, will 
cause the displayed HTML text to be inserted.

The tools on the lower tool bar are all Type 2 tools.    

To keep up with changes in HTML and to permit you to configure the editor to suit your style of working, 
HTML Assistant provides a special "User Tools" list for your own custom Type 2 tools.

.



User Tools
User Tools are Type 2 (insertion) tools, customized with text provided by the user.

This permits users to create new insertion tools as new HTML tags become available, or to set up text for 
any purpose, that can quickly be inserted at the cursor position.

An unlimited number (well...almost) of User Tools can be created.    They can be deleted or modified at 
any time and are automatically saved when exiting the program.

A few user tools are provided with the program package to illustrate what you can do.

The User Tools are displayed in a drop-down list box on the tool bar.    Clicking on an item in the list will 
cause its text to be inserted at the cursor.

See also:
Creating Tools that Insert an EOL (Carriage Return/Line feed)



Editing User Tools
The User Tools list can be changed by clicking on the 'Edit User Tools...' item in the "Options" menu, or by
selecting the small button, labeled "E" (for "Edit"), adjacent to the User Tools list. 

Either of these actions will cause an "Edit User Tools" dialog box to appear.    

The buttons on the right side of the dialog box, along with the contents of the text box at the top, are used 
to modify the contents of the User Tools list.    Use the buttons, to delete, insert, append and replace list 
items (whenever the mouse cursor is passed over it, the function of each button is described on the main 
window's status bar ).

Click on the "Transfer to user tools list"    button to copy the edited list to the User Tools list on the main 
window tool bar .    Selecting the "Close" button will cause the edit dialog box to close without altering the 
User Tools list on the tool bar.    The contents of the edit window's list box will be preserved until you quit 
the program.

When you exit HTML Assistant, the User Tools in the tool bar list will automatically be saved for use in 
future editing sessions.



User Tools files
The "File" menu on the "Edit User Tools" dialog permits you to save your lists of User Tools as files, and to
reload them for later use.    In this way, you can build sets of special purpose user tools as the need 
arises.    For example, you might have a set of tools for creating    forms, another for a specialized 
application that involves tables, etc.    An option in the "File" menu permits you to combine different User 
Tools files by appending to the list box.

User Tools files have the suffix, ".UT".    A file called "DEFAULT.UT" is automatically loaded to the User 
Tools list when HTML Assistant starts.    The User Tools list is saved to this file when the program ends.



Creating Tools that Insert an End-of-Line
To create a user defined tool that inserts a carriage-return/linefeed pair (End-Of-Line marker) enter "\n"    
-- without the quotation marks --    in the list box item where you want the EOL to be created.

For example to create a tool that inserts an EOL followed by a paragraph mark followed by another EOL 
you would use the following text in the tool's list box text:

  \n<P>\n



The Auto Repeat Function
To repeat the action of the tool that was last used, simply press the right mouse button or press CTL-R.    
This function is also available from the 'Command' menu and as a command button in each file display 
window.



Autoinsert Paragraph Markings
Found in the 'Command' menu this item will insert new paragraph marks ("<P>") at every End of Line 
(carriage return-line feed pair) in the selected text.    You must select text for this command to work.

To automatically insert paragraph marks in the whole file, select the 'Select    All' option from the 'Edit' 
menu, and then use the 'Autoinsert Paragraphs' command.



Printing
The contents of the current edit window may be sent to the default Windows printer by selecting the 'Print'
option in the file menu.

This is a simple print routine that transfers the text (as a 'character string') to the printer.    If a line ending 
with a CR/LF pair is longer than the width of a page, the end of the line will not be visible when printed.

Files that have no CR/LF pairs (i.e., some UNIX files) may appear as a single (truncated) line of text.

For more elaborate print formatting you can use any word processor that will accept standard MS-DOS    
or UNIX text files. 



Edit/Build URL Files
Selecting this item from the 'URL' menu permits you to edit and combine commented URLs    (URL    is an 
abbreviation for Uniform Resource Locator) from different sources.

For example, you may quickly combine selected URLs from    Cello Bookmark files with other URLs 
automatically extracted from Mosaic menus and 'Hotlists.' 

While perusing news groups, mailing lists, etc., you might cut and paste URLs into text files (with Notepad
or HTML Assistant)      and later combine these with    other files.

Of course, once the URLs    and comments from various sources are loaded into the editor's list boxes 
they may be edited and supplemented with new URLs that are manually typed in.    If they are saved    as 
HTML Assistant URL files (the default type) they can later be loaded into an edit window for more 
extensive editing and    reorganization.

You may also convert and save any combination of URLs from any of these sources into a Cello 
Bookmark file.

See also:
Operation of the URL Editor



Operation of the URL Editor
When the 'Edit/Build URL Files' option is chosen, a window with two list boxes and two text boxes, and 
some control buttons pops up.

When a file is loaded, any necessary conversions (for Cello bookmark) or extractions (for Mosaic.ini files) 
are performed, and the list boxes are filled with the URLs from    the file (the files themselves remain 
unchanged).    One list box contains a list of all the URLs found in the selected file.    The other list box, in 
corresponding positions in the list, contains comments or descriptions of the URLs in the first box.

You may create your own files    or add to the contents of existing files, by clicking the 'Add New URL' 
button and entering URLs and Comments into the corresponding text boxes.    When an entry is complete 
use the 'Accept New URL' control button to save the new data into the list boxes.

Clicking on a data item in either list box causes the URL and its associated comment (if any) to be copied 
to corresponding text boxes.    The contents of the text boxes may be edited and the changes can be 
saved.    Clicking the 'Accept Edited Text' button makes the changes part of the file.    Saving the file will 
make them permanent. You may add and delete URLs and comments by clicking the appropriate control 
buttons.



Combining Files
Files may be combined by selecting the "Append " option button (displayed between the two list boxes) 
when a file is to be opened and there is data already in the list boxes.    The new data will be appended to 
the existing data.

Files are saved as HTML Assistant URL Files unless the 'Save as Cello Bookmark File...' option in the 
'File' menu is selected.



Direct Conversion Of Files to HTML Text
By selecting the 'Autoconvert File to HTML' option in the 'URL' menu, HTML Assistant permits you to 
automatically convert certain files that contain URLs (along with    optional comments or descriptions) 
directly to HTML text in a new HTML Assistant text editing window.    This is a quick and easy way to build 
HTML files for editing, testing or browsing.

When a file type is selected (from the popout sub menu) you will be presented with a file selector box 
from which you may select a file to convert (or you may cancel the operation).

As soon as a file of the appropriate type is selected, the conversion process begins. In a few seconds 
when conversion is complete    the URLs that were found in the file, now properly converted to HTML text 
separated by paragraph marks, are automatically inserted into a new text window for further editing or 
testing.

 You can elect to convert data in the following types of files to HTML :

Cello Bookmark Files (*.bmk files)

HTML Assistant URL Files (*.url files)

Mosaic Initialization Files (*.ini files)



Cello Bookmark files (*.bmk files)
Cello Bookmark files are used by the Cello browser for saving URLs so that browsed documents may be 
revisited.    They have their own format and their file names usually have the suffix ".bmk".



HTML Assistant URL Files (*.url files)
HTML Assistant URL files are text files containing URLs and, possibly, descriptions or comments.    Each 
record, or line, in the text file contains a URL optionally followed by a comma (,) and a description.
An uncommented line looks like this:

http://info.cern.ch/example.html
A commented line would look like:

http://info.cern.ch/example.html,Sample Page 
Because HTML Assistant can automatically convert these files into an HTML text document, they make 
an excellent way to store or 'capture' interesting looking URLs for later perusal. 

If, for example, while browsing news groups, mailing lists or the World Wide Web itself,    the URL for an 
interesting looking home page is presented, you can simply 'Copy' the URL from the document and 
'Paste' it into a text file using Notepad (or HTML Assistant).    The URL should be saved WITHOUT 
quotation marks. 

If you wish, you may enter a comma (,) after the URL (but before the "Enter" key is pressed), followed by 
a description or comment which will appear as the 'live' or 'clickable' item in the HTML file when viewed by
a browser.    If you don't enter a comment, HTML Assistant will add a copy of the URL (for display as the 
'live' selectable item) to the HTML file at conversion time.

Just be sure you press the "Enter" key at the end of each line.    Make sure that the URL and its comment 
(separated by a comma) appear on one logical line. It may look like two or more lines if the editor window 
is narrow, but as long as the "Enter" key was pressed only at the end of the URL-Comment combination, 
the item is    a single record and will be processed properly.



Mosaic Initialization files (Mosaic.ini)
The Mosaic WWW browser uses an initialization file with the name, "Mosaic.ini" for storage of setup 
parameters.

Included in this file are lists of menu items that contain descriptions and URLs that can be executed by 
Mosaic when the descriptions on the menus are selected (or 'clicked').

Also included in the file is a 'Hot List' of user selected URLs gathered during browsing expeditions on the 
Web.    These do not have descriptors associated with them.

The URLs in Mosaic initialization files are what is    converted to HTML text by HTML Assistant.    If the 
URLs come from menu items their associated menu captions are displayed as the selectable on screen 
text.    'Hot List' items are displayed with a copy of the stored URL as the on screen text.



Using a WWW Browser for Testing
HTML Assistant permits you to display your HTML annotated file (without leaving HTML Assistant) with 
any browser that will permit the use of the name of a file on a local disk as a startup file.

If you click on the 'Test' button in an edit window or select the 'Test' option from the 'File' menu, you will be
led through a process which includes selecting your test program and    saving its name for future use. 

The 'Test' function uses the last saved version of your file. If your file has changed since you saved it last, 
you will be given an opportunity to save it before testing.

Alternatively, you may select the 'Autosave Before Testing' feature in the 'Options' menu, and your file will 
be saved automatically.

The 'Test' button or menu option will be disabled if the active file is a new file and you have not yet saved 
it.    You must always save a new file at least once before you can test it. 

To test the program, HTML Assistant simply runs the program you designate as your test program, with 
the full path and file name of the active edit file in the command line.    Therefore, for the test to work, the 
browser you use must be able to use a local file specified on the command line as its startup file.

You also need to be concerned with    where your test program expects to find configuration files, 
initialization data, etc.    We have sometimes found it necessary to copy some or all of these files to HTML 
Assistant's home directory or to the directory where the files to be tested reside.

We find that Cello and Mosaic (Version 2 or later) work well as test programs. HTML Assistant can take 
advantage of Cello's Dynamic Data Exchange capability.      You can easily try other browsers as they 
become available.



Using Dynamic Data Exchange (DDE) with a Browser
Use of DDE (Dynamic Data Exchange) with a test browser permits relatively smooth back and forth 
transitions from HTML Assistant to the browser and vice versa.    It eliminates the need to close and 
restart the test browser each time you want to test a file.

If you are using Cello as your    test browser, HTML Assistant gives you the option of using DDE (Dynamic
Data Exchange) to send Cello the name of the HTML file you want to test.    If Cello is not loaded, HTML 
Assistant loads it.    Once Cello is loaded and you do not close it, it will not have to be reopened whenever
you want to test a file.    Each time you select the item in the File menu for testing using DDE, the name of
the file you are testing is sent to Cello and it becomes the active, topmost application.

When using DDE, Cello does not always refresh itself if your file has changed.    That is, changes in your 
HTML text will not always be immediately seen when you invoke Cello.    If that happens click the 'Reload 
Document' option in Cello's file menu to ensure that you are viewing the latest saved version of your 
HTML file.

Clicking on the small 'Return to HTML Assistant' box in the lower right    corner of Cello's window will 
return you to HTML Assistant without closing Cello.

The default test mode is DDE off.    To set the DDE option on, go to the 'Options'    menu and click on the 
DDE option.    You can tell it has been selected if it is checked.    That's all there is to it.      If you run into 
problems with DDE, go back to the Options menu and click it again to deselect it and return to the test 
mode without DDE.

If other browsers permit DDE, HTML Assistant's DDE capability will be updated to work with them.



What is HTML Assistant Pro?
[Note: HTML Assistant Pro is constantly being revised and improved. Contact 
harawitz@fox.nstn.ns.ca for the latest information about its features.]
HTML Assistant Pro is an advanced version of HTML Assistant that may be ordered by Email, mail, 
telephone    or FAX.

While HTML Assistant is a complete and fully functional hypertext editor, HTML Assistant Pro makes 
creating, editing and collecting HTML documents even faster and easier.

HTML Assistant Pro adds the following features to those already included in HTML Assistant: 

A printed manual which features a "Beginners Guide to HTML" plus a step-by-step tutorial to lead you
through the creation of your first HTML page.

An Automatic Page Creator, a wizard-like feature which permits rapid creation of HTML text pages for
use with WWW browser programs. Minimal knowledge of HTML is required, and attractive 
screens with your own selected hypertext links can be created in a few seconds. This makes it 
easy to create 'menu' pages on your hard drive so you can systematize and organize URL links 
by subject, date, etc.

A filter to remove HTML markings from text.    Additional filters can reformat text paragraphs for 
improved readability.

Ability to load files that are longer than 32K. Large (> than 32K) files will be loaded in segments. The 
segment size can be set by the user.    

File search features - you can search for and load files containing key words which you select. 

An option to extract (without altering the original file) all the link URLs from an HTML text file and 
display them in a text edit window.    Files can be of ANY size.    The URLs are displayed in "HTML
Assistant" format:URLtext,Clickabletext.    The displayed URL text can be edited and saved as 
HTML Assistant '.URL' files.    

Support for the ISO-Latin character set - can automatically convert ISO ASCII codes in text files to 
displayable HTML

An option to save DOS text files as UNIX text

Full support, including availability of enhancements and upgrades



HTML Assistant Pro - Automatic Page Creator
The Automatic Page Creator supplied with HTML Assistant Pro permits very rapid creation of HTML text 
pages for use with WWW browser programs.      Minimal knowledge of HTML is required, and an attractive
screen with your own selected hypertext links can be created in a matter of seconds.

For WWW information providers, this makes it quite easy to create pages for others to view.

For active    collectors of information on the World Wide Web, the Automatic Page Creator (as well as 
HTML Assistant Pro's other features) makes it easy to organize    links to information in ways that make 
sense.    You can quickly select links from different pages and files and combine them into a single page 
with headings and descriptions of your choice. 

Be Your Own Internet Organizer
The Automatic Page Creator makes it a snap to organize your Internet experience. It becomes a simple 
matter to create hierarchies of menu pages which access other pages stored on your local disk drive.    All
of these can be annotated with text of your choice. 

The Automatic Page Creator allows you to very quickly put together presentation pages on any topic.    
Together with the URL File Editor/Builder, you can organize links to WWW data by subject, date or in any 
other way that suits you.    

With HTML Assistant Pro you can easily build attractive and pleasing layouts that incorporate headers, 
divider lines, text and links to other pages and graphics on your own hard drive or at remote sites.

HTML Assistant Pro makes keeping track of your work on the Internet not only manageable, but an 
enjoyable and esthetically pleasing experience.

How to order HTML Assistant Pro.



How to Order HTML Assistant Pro
HTML    Assistant Pro may be ordered via Email, mail, telephone or FAX.    The fastest way to order is by 
FAX, telephone or Email with a credit card.    

Payment may be made by money order, check, VISA or Master Card.

Arrangements can be made to accept purchase orders from schools, established firms, government and 
other organizations.

To order or for more information contact Brooklyn North Software Works as follows:

Email:

harawitz@fox.nstn.ns.ca

Telephone/FAX: 

(902) 835-2600

Mail:

Brooklyn North Software Works

25 Doyle Street

Bedford, Nova Scotia

Canada B4A 1K4

As of January 1, 1995, US Dollar Price    is $99.95 plus postage and handling ($10 in North 
America, $15 elsewhere) . 
Price is subject to change.    Check with us for current pricing.
If you wish to pay by check or money order in US Dollars send US$99.95 plus US$10.00 for postage and 
handling in North America    (US$15    outside North America).    Total    in US Dollars is $109.95 ($114.95 
outside North America).

Credit Card users:    Because we are required to write credit card orders in Canadian dollars the actual 
US$ amount billed by your local bank will vary slightly with the exchange rate at the time your account is 
charged.

Canadians: Contact us for Canadian dollar prices
All Credit card orders must include the following information:

1. Full credit card number      

2. Type of card (MasterCard or Visa only) 

3. Expiration date. 

All orders:
1. Be sure to include your full name and post office address, including postal code, with your order.    

2. Please include your Email address, and/or a FAX or telephone number so we can contact you 
quickly in case we need additional information.

3. Shipment in North America will be via post.    FAX or Email if you would like to make other 
arrangements.

About purchase orders, multiple licenses and quantity discounts
Arrangements can be made to accept purchase orders from schools, established firms, government and 



other organizations.

Institutional licenses and quantity discounts are available. 

Email    harawitz@fox.nstn.ns.ca or Telephone/FAX (902) 835-2600 for information.

Equipment requirements, diskettes, etc.
HTML Assistant Pro requires an    80386 (or better) IBM PC or compatible computer with at least 4 
megabytes of RAM, Microsoft Windows 3.1 (or later) and less than 1 MB of hard disk drive space.    (If you
are now using HTML Assistant, you can use HTML Assistant Pro with the same equipment.)

Unless otherwise specified, the software will be sent on a 3.5 inch high-density diskette.    If you require 
other media please let us know.




